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Introduction
Ansys, Inc. uses the FlexNet license manager for all its licensed products. This guide provides you with
the instructions necessary to configure the client-side license manager settings.

Supported Hardware Platforms

• Linux x64 (linx64)

• Windows x64 (winx64)

For specific operating system requirements, refer to the installation guide for the platform you are
running. For platform support information, see the Platform Support section of the Ansys Website.

Summary of New and Changed Features

Listed below is a summary of those licensing items that are either new or have been changed since the
last release. For a list of all major new and changed features of any product, see the Release Notes
document for that product.

• FlexNet Publisher used by the Ansys License Manager has been updated to version v11.19.0.1 .

• OpenSSL used by the Ansys License Manager has been updated to version 1.1.1q.

• Zlib used by the Ansys License Manager has been updated to version 1_2_12.

1. Understanding Ansys Common Licensing

Ansys Common Licensing (ACL) creates direct communication from all Ansys applications to the FlexNet
Publisher server. ACL is launched when an application makes its first licensing call and continues to run
until all connected clients exit. ACL uses a random port to listen for all the clients. There is one ACL per
process tree, meaning the parent and all the children connect to the same ACL launched by the parent.

1.1. License Sharing with Ansys Common Licensing

By default, licenses are shared in a parent/child process tree. Ansys Common Licensing follows par-
ent/child/max logic. Here are a few examples of this logic:

• If the parent checks out the increment "meba" and the child tries to check out the same increment
"meba" then the net result is there is only one increment "meba" consumed from the license serv-
er/pool.

• If the parent checks out increment "meba" and the child tries to check out the 2 counts of the
same increment "meba" then the net result is there are two tasks of "meba" consumed from the
license server/pool. This is an example of max logic

• If the parent checks out 1 count of the increment "meba" N number of times, then the net result
is there is only increment "meba" consumed from the licensing server/pool.

v
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Parent/Child across machines/process tree: This process enables the parent child sharing for the
specified license features with child being on a different machine.

User Host Display: This process enables applications to share the same listed features across multiple
instance of the applications for a specific user tied to the host/display.

HPC Parametric Sharing: HPC parametric sharing enables applications to use a single solver license
and anshpc_pack or 8 anshpc features for each additional variance. This also allows applications to
share anshpc_pack increments for core checkouts from the solves started as variances of the same
context. For more information on HPC Licensing, see HPC Licensing (p. 19).

Note:

Queuing is not supported in any type of license sharing.

Release 2023 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
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Chapter 1: Ansys Licensing Settings Utility
This chapter explains how to use the Licensing Settings Utility to configure connections with both
FlexNet Publisher and Elastic Licensing servers. The Licensing Settings Utility is installed automatically
when the product is installed; you do not have to take any further steps to run as a client if you have
installed a product.

1.1. Understanding the ansyslmd.ini File

A number of the options in the Ansys Licensing Settings Utility modify the ansyslmd.ini file that
is located in the licensing directory. Because of this, it is generally a good idea to have an understanding
of the contents and purpose of the file. Entries in the ansyslmd.ini file tell Ansys, Inc. products
which license server(s) to query to find a valid license. Using this option allows all users at your site to
use this setting without having to individually set the ANSYSLMD_LICENSE_FILE environment variable
to specify the license server machine(s). It also eliminates the need to have a copy of the license file on
every system at your site. Additionally, if you are using Ansys Elastic Licensing, the ansyslmd.ini
file contains your Cloud License Server ID (CLSID) and pin (CLSPIN).

1.1.1. ansyslmd.ini Server Entries

The order that the SERVER lines are listed in the ansyslmd.ini file dictates the order in which the
license servers are queried when attempting to check out a license.

You are not limited to designating one set of license server machines for your network. You can have
multiple single-server or three-server (redundant triad) licensing systems on your network. In this
situation, you would have certain licenses connected to a set of server machines (one or three) on
the network, and other licenses connected to a different set of server machines (one or three) on the
network.

Each server's specification entry in this file will typically begin with SERVER= to specify the server port
numbers.

On a single server:

SERVER=<flexnetport>@<host>

For multiple single servers, each server should have its own SERVER= lines.

On redundant (triad) servers on Linux platforms:

SERVER=<flexnetport>@<host1>:<flexnetport>@<host2>:<flexnetport>@<host3>

Windows platforms use semicolons (;) instead of colons:

SERVER=<flexnetport>@<host1>;<flexnetport>@<host2>;<flexnetport>@<host3>
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Do not use commas as separators; use colons (:) on Linux machines and semicolons (;) on Windows
machines.

You must use the port@host format; you cannot enter a path or a filename in place of the hostname.

Modifying the Server Order:

You can use the ANSYSLMD_LICENSE_FILE environment variable to supersede the existing server
configuration. The servers that are defined in the ANSYSLMD_LICENSE_FILE environment are added
to the beginning of the server path.

For example, if your ansyslmd.ini file contains the line SERVER=server1;server2 and and your AN-
SYSLMD_LICENSE_FILE environment variable contain server3 and server4, your server path will be
server3, server4, server1, server2.

If you set the ANSYSLMD_LICENSE_FILE environment variable on a three-server (redundant) system,
specify all three systems in the same order as the SERVER lines are listed in the license file. If you
specify only the master and it is down, you could see a "License Server Down" or "No License Found"
message and the search for a license could fail. Join redundant or multiple single server systems by
separating the system names with colons on Linux systems and semicolons on Windows systems.

1.1.2. ansyslmd.ini Elastic Licensing Entries

The ANSYS_ELASTIC_CLS entry contains your computer's CLSID and CLSPIN. This entry is appended
to your ansyslmd.ini file when you add or update them by using the options in the Ansys Licens-
ing Settings Utility. For more information, see Changing the Elastic Licensing PIN .

ANSYS_ELASTIC_CLS=<CLSID>:<CLSPIN>

Alternatively, if you are comfortable modifying the text in the ansyslmd.ini, you can enter the
CLSID and CLSPIN manually.

1.2. Using the Ansys Licensing Settings Utility

To run Licensing Settings Utility on Windows, choose Start> Ansys 2023 R1> Ansys Licensing Settings
Utility.

To run the utility on Linux, type the following:

/ansys_inc/v231/licensingclient/linx64/LicensingSettingsUtility/LicensingSettingsUtility

To use the utility, select an action from the list of options on the left.

1.2.1. Defining FlexNet Publisher License Servers

1.2.2. Enabling Elastic Licensing

1.2.3. Setting HPC User Preferences

1.2.4. Setting Borrowed Increments

1.2.5. Gathering Diagnostics

Release 2023 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
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1.2.1. Defining FlexNet Publisher License Servers

You are asked to specify your license server during the product installation if you have not done so
during a previous product installation. If you did not specify your license server during the product
installation or if your license server has changed, use the FlexNet Publisher option to define the
FlexNet Publisher server, default communications port and usage order. This information is stored in
the ansyslmd.ini file.

• To add license servers, click the "plus" icon (located below the existing servers) and enter the
communications port and server hostname(s) then click Test to verify the configuration. If the
server is available, a green check mark is displayed to the right of the server information. Click Save
to complete this process.

Note:

To specify redundant triad servers, enter the hostname for each of the three servers in
the spaces available.

• To remove a license server, click the "minus" icon to the left of the appropriate server and then
click Save to complete this process.

• To adjust the order of the servers in your list, click and hold the "double arrow" icon to the left of
the appropriate server and drag the selection to the new postion within your list. Click Save to
complete this process. The order of the servers dictates the order in which they are queried when
attempting to check out a license.

Note:

Unresponsive servers can slow the license check-out process. If a license server is likely to
be offline or otherwise unresponsive for an extended time, consider removing it from the
list.

1.2.2. Enabling Elastic Licensing

Click the Elastic Licensing option to enable elastic licensing and import your Elastic License Server
and Elastic License Server PIN.

To enable elastic licensing:

1. Click the Enable Elastic Licensing check box option.

2. Click Import CLS ID and CLS Pin and browse to the directory containing json file supplied by
your elastic licensing administrator.

3. Select the file and click Open.

4. Click Save.

This information is saved to your ansyslmd.ini file.

9
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To disable elastic licensing:

1. Uncheck the Enable Elastic Licensing check box option.

2. Click Save.

To import new elastic server information:

If license administrator changes the PIN for the Elastic License Server, client-side users should perform
the following steps.

1. From the Elastic Licensing screen, click the Import CLS ID and CLS Pin button.

2. Browse to the directory containing json file supplied by your elastic licensing administrator.

3. Select the file and click Open.

4. Click Save.

Your ansyslmd.ini file is updated, and the ID and PIN are displayed in the Ansys Licensing
Settings Utility.

1.2.3. Setting HPC User Preferences

Clicking the User Preferences option displays the HPC products that are available and the order in
which HPC licenses are checked-out.

• To change the license priority, click and hold the "double arrow" icon to the left of the appropriate
license and drag the selection to the new position within your list. After you have modified your
list, click Save to retain your changes.

• To disable an HPC license, disable the check box to the left of the appropriate license and then
click Save.

1.2.4. Setting Borrowed Increments

Clicking the Borrow option, displays a drop-down menu containing a list of borrowable licensing in-
crements (available only on Windows machines). License borrowing allows a user to take a license
for use while not connected to the network.

Note:

This feature is available after defining a FlexNet server.

To borrow license increments:

1. From the Borrow screen, select the license increments you wish to borrow from the Borrowable
Increments drop-down menu.

2. Set the return date for each increment.

3. When you have finished selecting your increments and setting the dates for each, click Borrow.

Release 2023 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
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4. When you are finished with the license increments, return to the Borrow screen and click Return
for the appropriate increment or Return All to return all increments.

1.2.5. Gathering Diagnostics

Clicking the Gather Diagnostics option and then clicking Generate gathers various licensing-related
files, logs and related information about your license client system and places them in a single directory
as well as a compressed file. This feature is useful if you want to easily review the files from a single
location, or if you need to send them to a technical support representative.
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Chapter 2: End-User Configuration
This section contains licensing configuration instructions for Ansys Workbench and client environment
variable settings used to modify licensing behavior on indivdual machines.

2.1. Migrating Custom User Licensing Preferences

For Ansys Workbench users, customized user licensing preferences (if present), are automatically migrated
when you install a new Ansys release. For example, if you already have Ansys release 2022 R2 installed
on your computer and you upgrade to release 2023 R1, your customized user licensing preferences (if
present), are automatically migrated to the new version.

If you are using an Ansys product other than workbench, you can manually migrate your customized
user licensing preferences by running the ansysli_util.exe file.

To run the ansysli_util.exe, follow the steps for your platform below:

Windows:

Where <Installation Directory> represents the path to the latest Ansys Product install, open an admin-
istrator command prompt window and issue the following command:

"<Installation Directory>\<Version Number>\licensingclient\winx64\an-
sysli_util.exe" -updateuserprefs -fromrevn <previous release>

Example:

"C:\Program Files\ANSYS Inc\v231\licensingclient\winx64\ansysli_util.exe"
-updateuserprefs -fromrevn 231

Linux:

Where <Installation Directory> represents the path to the latest Ansys Product install, open a command
line window and issue the following command:

"<Installation Directory>/<Version Number>/licensingclient/linx64/an-
sysli_util" -updateuserprefs -fromrevn <previous release>

Example:

13
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"/ansys_inc/v231/licensingclient/linx64/ansysli_util" -updateuserprefs -
fromrevn 231

Note:

For both the automatic and the manual user licensing preferences migration, ansysli_util
reads the ansyslmd.ini file or the ANSYSLMD_LICENSE_FILE environment variables to determine
the correct license server.

2.2. Ansys Workbench Licensing Methods

Ansys Workbench users can specify which of two licensing methods to use:

• Share a single license between applications (shared mode). The Share a single license between
applications if possible is enabled by default in Ansys Workbench.

• Use a separate license for each application (separate mode) by disabling the Share a single li-
cense between applications if possible option in Ansys Workbench.

Single License Sharing 

Ansys Workbench allows you to work across multiple instances of the same applications while
consuming only one of a single type of license per user per session. Using shared licensing, the
active application holds the license, preventing other applications that are sharing that same license
increment/key from using it during that time. For example, trying to do multiple solves of same
type at the same time would be a concurrent event.

Sharing licenses is tied to the license keys the application is using. For example, if the application is
using license key "meba" then you cannot run other application instances or applications sharing the
license key "meba" at the same time.

Single license sharing allows you to progress through your analysis, from specifying engineering data
through building, setup, solving, and finally, reviewing your results, all under the same licenses. The
application holding the license must close or issue a PAUSE command or receive an automatic release
request to release the license and allow another application to use it. Licenses cannot be released while
an application is actively performing a concurrency event (for example, an application cannot release
a license in the middle of a solve operation because the license cannot be released until the solve op-
eration is completed).

Single license sharing applies only to licenses of the same type (for example, Ansys Mechanical Enterprise).
Choosing this option does not affect your ability to use licenses of different types simultaneously (for
example, Ansys Mechanical Enterprise for one task and ANSYS CFD for another).

Because this method is the default, you do not have to take any action to run this way.

Explanation of License Type and Examples 

License type is primarily by license increment. It is possible to use different license increments
based on the operations performed within a single Ansys Workbench session. For example, Geometry
import, meshing and solving will checkout different license keys based on the capabilities the ap-
plication is requesting. For all applications, ANSYS licensing will first look at what other licenses
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are opened within this session: if any other licenses being used within this session fulfill the needed
capabilities Ansys licensing will share an existing license. If not, a new, different license is checked
out.

Restrictions for Single License Sharing:

You cannot run two concurrency events simultaneously (for example, you cannot solve two models of
the same type simultaneously) with one license.

If you are using a license for one application, other applications may still not be able to share that license
if those applications require capabilities not supported by the license. For example, you cannot share
a Mechanical Enterprise license with a Fluent application.

Single License Sharing in Ansys Workbench Applications

Ansys Workbench applications handle single license sharing differently:

Mechanical:

You can launch the Mechanical application and move between its components (such as Meshing, Setup,
and Solve). The active component will control the license while completing its operations and will release
the license as soon as the operation is completed. For example, when you mesh, the meshing component
will control the license during the meshing operation and then immediately release the license when
the operation is completed. During the meshing operation you cannot use the meshing increment in
any other systems under Ansys Workbench until the first system mesh is done and the license is released.
The other meshing component, if present in the subsequent systems, will go into read-only mode while
the first system mesh is still in progress.

Note:

Applications in read-only mode because of shared licensing do not refresh their license
status automatically. Once the shared license is released by the editor that had consumed
it, you must trigger Mechanical to query the license status. The most straightforward
way to do this is click outside the Mechanical application window and then click back
in the window to cause the license availability to be rechecked.

Mechanical APDL:

This application consumes a license as soon as you launch it and retains that license until it is finished.
If you launch the Mechanical APDL application interactively, the license is retained until you either close
the application or issue a PAUSE command at the Mechanical APDL command line. PAUSE allows you
to temporarily release the license for another application to use. No other operation other than SAVE
or EXIT is permitted while PAUSED. When the second application has finished and releases the license,
issue an UNPAUSE command from the Mechanical APDL command line to resume its use of the license.

CFX, Fluent, Autodyn, Polyflow:

These applications consume a license when launched and retain the license until they receive a request
from another application to release it. For example, when you open CFX-Pre, it will obtain and control
the license. It will retain the license until you close the application or until another application (such as
the CFX solver) requests it.

15
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Autodyn and Polyflow also provide a manual PAUSE increment that allows you to interrupt Autodyn
or Polyflow and release the license, temporarily, for another application to use.

Electronics:

Electronics applications do not support license sharing.

Separate Licenses  

By using the separate-licenses method, Ansys Workbench requires a separate license for each ap-
plication. By using this method, you can move freely between the many applications that you
might require during an analysis in Ansys Workbench if you have sufficient licenses. You can leave
each application running and easily move between them at any point during the analysis, even if
one of the applications is actively using the license (such as during a solve process). The disadvantage
to this method is that you could potentially consume many licenses.

To activate the separate licenses method, open Ansys Workbench and click Tools>Options. From the
Project Management view, disable the Share a single license between applications if possible option.
After disabling this option, close options dialog box and restart Ansys Workbench.

Examples of Using Separate Licenses 

You have two "ansys" increments. When you open and solve a model in the Mechanical application,
you consume one "ansys" increment. If you link that Mechanical analysis to a Mechanical APDL
system, you would consume a second "ansys" increment when you launch the Mechanical APDL
application, if you have not closed out of the Mechanical application. Neither of these licenses
would then be available for other users until you closed out of one or both applications.

2.3. Client Environment Variable Settings

You can set the following environment variables on individual machines to control their behavior, espe-
cially if you need it to be different from the general site configuration. These settings are especially
useful for situations where you are testing a new product installation/license manager installation on
a single machine before full site deployment, or other similar situations.

ANSYSLMD_LICENSE_FILE

Can be used to identify a license server machine or license file. If set, this specification is used
before any other license path information. The default port number assigned to Ansys, Inc. is
1055. Therefore, if your server has the hostname alpha1 and the IP address of 10.3.1.69, you
can identify the server to use as 1055@alpha1 or 1055@10.3.1.69.

ANS_FLEXLM_DISABLE_DEFLICPATH

Indicates that the default license path should not be searched when determining the licensing
path in the Ansys product. When this environment variable is set:

• Only ANSYSLMD_LICENSE_FILE environment variable setting is used.

• Only the ANSYSLMD_LICENSE_FILE environment variable setting is required.

• Settings in the ansyslmd.ini file will NOT be used. It will ignore the local server and
will ignore the Specify the License Server setting.
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ANSYSLI_TIMEOUT_CONNECT

Used to specify the amount of time that elapses before the client times out if it cannot connect
to the server. Default is 20 seconds. Minimum timeout period you can specify is 5 seconds and
the maximum is 60 seconds. If the client determines that a server is not available in less time,
it will cancel immediately.

ANSYSLI_TIMEOUT_TCP

Used to specify the amount of time that elapses before the client times out if it cannot get a
response from the server. This setting applies only when the license server is running but is
responding slowly (generally because of network issues or server load). Default is 60 seconds.
Minimum timeout period you can specify is 30 seconds and the maximum is 300 seconds.
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Chapter 3: HPC Licensing
Ansys, Inc. offers multiple high performance computing license options, described below.

The HPC license options below cannot be combined with each other in a single solution. For example,
you cannot use both Ansys HPC and Ansys HPC Pack licenses in the same analysis solution.

See the applicable product documentation for instructions on configuring and running a distributed
solution.

3.1. Ansys HPC

These physics-neutral licenses can be used to run a simulation across multiple cores and work with
most Ansys applications. Some Ansys applications can utilize any combination of CPU and GPU processors.
Other applications are limited to CPU processors only. Contact your Ansys sales representative for a
complete list of products that can be used with Ansys HPC.

Most Ansys applications allow you to use four cores without using any HPC licenses; Ansys HPC licenses
add to this base functionality. For example, an Ansys CFD Enterprise user using twelve cores will consume
only eight Ansys HPC licenses. Contact your Ansys sales representative for a complete list of applications
with this option.

Note:

HPC licenses and HPC Pack licenses cannot be combined within the same solution. Addition-
ally, HPC licenses do not participate in license borrowing.

3.1.1. Ansys HPC Pack Licenses

Ansys HPC Pack Licenses can be used to run a simulation across multiple cores and work with most
Ansys applications. Contact your Ansys sales representative for a complete list of applications that
can be used with Ansys HPC Pack Licenses. Individual HPC Pack Licenses cannot be split between
multiple users or between multiple analyses.

Products with Included Cores

HPC Per
GPU

GPU SupportIncluded Parallel
Cores

Application/Module

N/ANo4 (2)Additive Print

8 (3)Yes4Ansys Rocky

N/ANo4Aqwa

N/ANo4Autodyn
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HPC Per
GPU

GPU SupportIncluded Parallel
Cores

Application/Module

N/ANo4CFX

N/ANo4Chemkin-Pro

8Yes4Circuit

N/A (6)Partial0 (5)Discovery

8Yes4EMIT

N/ANo4Explicit

N/ANo4FENSAP

1 (4)Yes4Fluent

N/ANo4Forte

8Yes4HFSS

N/ANo4Icepak

N/ANo1 (1)LS-DYNA

8Yes4Maxwell

Partial4Mechanical APDL

N/ANo1Motion

N/ANo4Polyflow

N/ANo4Q3D

N/ANo4RBD

N/ANo4SIwave

N/APartial (only
Preview)

4Speos

1. Ansys LS-DYNA HPC needed

2. Maximum 12 cores

3. Requires Ansys Rocky HPC

4. A maximum of 50% of the HPC tasks can be used to enable GPUs, for example 2 HPC Packs enables
a total of 36 cores and a maximum of 18 can be used for GPUs.

5. HPC solves are provided by the underlying physics solver license.

6. Discovery offers GPU-based solves in Explore mode, which does not cost any HPC packs.
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HPC Packs per Simulation

You may only borrow one Ansys HPC Pack license at a time.

3.1.2. HPC License Sharing (System Coupling)

When running a system coupling calculation using multiple solvers. Each solver has to check out its
own HPC licenses. For example: A system coupling calculation where Fluent is using six cores and
Mechanical eight cores would require the simultaneous checkout of the following licenses.

Fluent: Requires the base CFD solver enabling the license plus either a HPC Pack, or 2 additional
Ansys HPC licenses

Mechanical: Requires the base mechanical solver enabling the license plus either a HPC Pack, or 4
additional Ansys HPC licenses

3.1.3. HPC Licensing with Hyperthread Cores

For Ansys HPC licensing, a hyperthread core is treated as being the same as a physical CPU core. If
you run a 24 core Ansys solution on a CPU with 12 physical and 12 hyperthread, you will consume
the number of HPC licenses required to enable a total of 24 cores. Typically, the 12 Hyperthread cores
will enable little or no speedup to the calculations and therefore hyperthreading is not recommended.
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3.2. Shared HPC Licensing for Concurrent Parametric Variations

Starting with Ansys release 2020 R2, HPC licenses may be used for concurrent simulation of parametric
variations, allowing you to leverage standard HPC licenses instead of extra solver licenses. Each variation,
after the first, requires 8 HPC increments or 1 HPC Pack increment. Similar to non-parametric simulations,
each variation provides 4 included parallel cores per variation. Additional HPC parallel cores are shared
across all variations, using the same HPC rules. All licenses that are consumed during a concurrent
parametric simulation are held for the duration of the simulation, based on the max count of each license
required for a given variation.

You can use the Ansys Parametric Licensing Calculator (https://ansys.com/parametric) to determine the
number of HPC Workgroup or HPC Pack licenses required.

HPC Parametric Example

6 Parametric Variations, 24 Cores/Variation

3.3. HPC Licensing Frequently Asked Questions

This section lists common questions you may have while setting up licensing.

Which files contain the HPC license preferences?

HPC license preferences determine whether an HPC Pack or individual HPC licenses are used first. The
preferences are stored in a .xml file.

Linux:
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~/.ansys/v231/licensing/license.preferences.xml

Windows:

%appdata%\Ansys\v231\licensing\license.preferences.xml

To set the HPC Licenses preferences, see Setting HPC User Preferences (p. 10).

Why do multiple core Ansys LS-DYNA calculations fail when I appear to have
HPC Pack or Ansys HPC licenses available?

Standard Ansys HPC licenses such as anshpc and anshpc_pack, cannot be used with Ansys LS-DYNA.
Ansys LS-DYNA uses Ansys LS-DYNA, dysmp, licenses to enable multiple core calculations.

How many HPC license are used when I run Ansys LS-DYNA on multiple cores?

When run on multiple cores, Ansys LS-DYNA will consume dysmp licenses. These licenses are available
for purchase in different quantities, as Ansys LS-DYNA HPC, Ansys LS-DYNA HPC-8, 16, 32,64,128 and
256. The licenses can then be added together, to enable the total number of cores requested by a cal-
culation. A calculation run on <n> cores, will consume a base Ansys LS-DYNA license (dyna), plus <n-
1> Ansys LS-DYNA HPC licenses (dysmp).

Does the number of CUDA cores on a GPU card change the number of HPC li-
censes used?

The number of HPC license consumed when using GPU cards to accelerate an Ansys solution depends
on the number of GPU cards used and the number of separate GPU engines on each card. The number
of HPC licenses consumed, does not depend on the number of CUDA cores, supplied by each separate
GPU engine.

Is there any disadvantage to not renewing TECS on my perpetual HPC license?

If you do not renew TECS on perpetual HPC licenses, the HPC licenses can only be used to enable
multiple core calculations for Ansys solvers that were released before the date of expiry, of the TECS.
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Chapter 4: Troubleshooting
This section contains information that may be useful when working with Ansys customer support.

4.1. Getting Additional License Debug Information

Use the following suggestions to display or generate additional error messages and debugging inform-
ation.

• View the licdebug file. The licdebug file is generated when you run an Ansys, Inc. application
and resides in the .ansys subdirectory under the directory specified by the TEMP environment
variable (Windows) or in the $HOME directory (Linux). The licdebug filename will vary depending
on the product but will follow the format licdebug.<product>.231.out. For example:

If a licdebug file already exists and is dated today, the information is appended. If it is dated before
today, the existing file will be renamed with a .old extension and a new file will be started.

– Mechanical APDL (Ansys): licdebug.ANS_SOLVER.231.out

– Ansys Workbench: licdebug.ANS_WB.231.out

– Mechanical: licdebug.MECH.231.out

– Ansys Fluent: licdebug.FLUENT_SOLVER.231.out

– Ansys Polyflow: licdebug.POLYFLOW.231.out

– Ansys CFX-Pre: licdebug.CFX_PRE.231.out

– Ansys CFX Solver: licdebug.CFX_SOLVER.231.out

– Ansys CFD-Post: licdebug.CFD_POST.231.out.

– Ansys ICEM CFD (includes AI*Environment): licdebug.ICEM_AM.231.out

– Ansys Icepak: licdebug.ICE_PAK.231.out

– Ansys LS-DYNA: licdebug.DYNA_SOLVER.231.out

– Connection functionality: licdebug.ANS_PM.231.out

Note:

The license debug file names include the current release of the application. Because not
all applications are updated with each release, it is possible to have lic\debug file names
that are appended with older release numbers. For example, it is possible to be running
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Ansys Release 16.1 but still have a product license debug log file name include 160 as in
licedbug.POLYFLOW.160.out.

The directory specified by the TEMP environment variable may be hidden on your system. To view
the directory and file, click My Computer. Choose Tools from the menu, and then click Folder options.
Click the View tab and select Show hidden files and folders. Click OK.

If after following these suggestions, the resulting debug information does not make sense, try these
suggestions:

• Confirm that the license manager was restarted or the license file was reread after any changes
were made to the license file. If you did not make any changes to the license file for the server,
check the date/time that it was last changed. Get the relevant path information from the debug
output. Also, confirm that the same path is being used.

• Try restarting the license manager and then attempt to run again. See if the same situation occurs.

• If you installed a new license file but are not seeing it even after restarting the license manager,
confirm that the correct license file is being used to start the license manager. In this case, neither
the client application nor the license manager is using the changed file. Also confirm that if site
or user license preferences were set, the preferences were updated with the new license inform-
ation.

• If the ansyslmd.lic file is at the end of the path and it is a license file that uses the license
manager daemon/service, then confirm that the license manager is started with the same path
as the ansyslmd.lic file's path. The license manager could be looking at one file in the client
application but the license manager daemon/service was started with another file.

4.2. Application Fails to Start

This section contains information that may be useful when addressing licensing issues on the Linux
platforms.

4.2.1. Application fails when initializing licensing on Linux Platform

When running Ansys applications on server versions of Red Hat 7x and CentOS 7x, Security-Enhanced
Linux (SELinux) can block ansyscl communications.

To correct this issue, make sure to establish rules within SELinux to allow Ansys applications (ansyscl)
to communicate with ansyslmd.

4.2.2. Mechanical application fails to start

A new preference is now available in Mechanical Workbench: Close Mechanical During Launch If
No License in the Tools > Options dialog, under the Mechanical category. If selected, this preference
terminates opening the application and displays a message if no license is available in the queue or
if the license checkout process fails. Selecting this preference can save time since otherwise the ap-
plication opens in read-only mode, which can be a lengthy process for large projects. You can obtain
license failure information in the licensing debug file.
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